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Complex software-security policies are difficult to specify, understand, and
update. The same is true for complex software in general, but while many tools
and techniques exist for decomposing complex general software into simpler
reusable modules (packages, classes, functions, aspects, etc.), few tools exist
for decomposing complex security policies into simpler reusable modules. The
tools that do exist for modularizing policies either encapsulate entire policies as
atomic modules that cannot be decomposed or allow fine-grained policy modu-
larization but require expertise to use correctly. This paper presents PoliSeer,
a GUI-based tool designed to enable users who are not expert policy engineers
to flexibly specify, visualize, modify, and enforce complex runtime policies on
untrusted software. PoliSeer users rely on expert policy engineers to specify uni-
versally composable policy modules; PoliSeer users then build complex policies
by composing those expert-written modules. This paper describes the design
and implementation of PoliSeer and a case study in which we have used PoliSeer
to specify and enforce a policy on PoliSeer itself.

1. Introduction

Although complex software-security policies are difficult to specify, understand,
and update, they arise often in practice. For example, a system administrator or
end user may wish to enforce a complex collection of constraints (i.e., a policy)
on an untrusted application to limit that application’s access to resources such
as files, memory, and peripheral devices, and to obligate the untrusted applica-
tion to audit security-relevant operations and employ appropriate cryptographic
protocols on network communications. In general, software-security policies tend
to become more and more complex over time, due to the emergence of new
attacks, users’ demands for relaxations to overly tight policy constraints, and
the development of new application areas, like medical databases, which require
domain-specific security and privacy considerations 2.
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1.1 Related Work

The trend of increasing complexity in software-security policies mirrors the
trend of increasing complexity in general software applications; however, many
tools and techniques exist to help software engineers specify, analyze, and modify
complex software applications. One of the most common techniques is modular-
ization; engineers can modularize software into independent, reusable compo-
nents (e.g., packages, classes, functions, aspects, etc.) that can be parameterized
by, and can communicate with, other components through well-defined inter-
faces. Decomposing complex software into simpler modules saves engineers from
having to manage software as a single, indecomposable code block. Integrated
development environments (IDEs) for software engineering typically provide good
support for navigating software modules #):22):23),25)

In contrast, recent efforts at creating tools for helping policy engineers spec-
ify arbitrary runtime policies have only permitted the management of indecom-

posable policies 79 12):15)-17),21),24)

These tools enable engineers to specify an
arbitrary runtime policy as an isolated and centralized policy module; however,
the tools do not enable engineers to decompose that centralized policy into sim-
pler subpolicy modules, which could be specified, analyzed, reused, tested, and
modified in isolation.

Other related efforts do allow users to specify, visualize, analyze, and/or com-
pose policies, but only in particular domains. For example, the Policy Visualiza-
tion Analysis tool provides a GUI for managing existing SE Linux policies 29; the
Expandable Grid manages access-control policies?” (which are a proper subset
of runtime-enforceable policies '®); the Policy Mapper manages location-based
access-control policies »; front ends for SPARCLE and PERMIS manage natural-
language access-control and privacy policies ©'®); and Fang and Firmato manage
firewall policies 1%,

The Polymer project has attempted to address the lack of tools for manag-

2:3) Polymer is a language and

ing compositions of arbitrary runtime policies
tool for specifying and enforcing runtime policies on untrusted Java-bytecode
applications. Polymer policies exhibit universal composability (every policy can
be composed with other policies). Polymer achieves universal composability by

(1) making all policies first-class objects (i.e., objects that are treated like all
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other values, which can be passed as arguments to and returned as results from
methods) and (2) requiring all policy objects to implement a standard interface.
Hence, a Polymer policy P can be parameterized by another policy P’; when P
has to decide whether and how to allow a security-relevant application event A
to occur, P may query P’ for a response to A and use that response to gener-
ate its own response. For example, a Conjunction policy might take two policy
arguments P, and P, in its constructor; the overall policy can enforce the con-
junction of P; and P, by always responding to security-relevant events with the
most restrictive of the responses of P, and P». In this case we call Conjunction
a superpolicy and P; and P; its subpolicies. As another example, an Audit su-
perpolicy may be parameterized by a policy P and a string S; then Audit can
blindly enforce P while logging all of P’s responses to security-relevant events
in a file named S. Using such techniques of parameterizing policies with other
policies, engineers can use Polymer to build complex runtime policies as composi-
tions of simpler subpolicy modules (Fig. 7 provides a high-level view of a complex
Polymer policy that specifies runtime constraints on email clients and is built by
composing simple subpolicy modules).

Although Polymer enables arbitrarily complex runtime policies to be specified
more conveniently as compositions of subpolicies, Polymer achieves this conve-
nience by requiring each individual policy module to be specified surprisingly
inconveniently. The inconvenience stems from Polymer’s requiring users to ad-
here to a complex programming discipline designed to partition policy code into
effectless (i.e., free of state updates and I/O operations) and effectful methods.
Figure 1 (which is based on a policy downloaded from the Polymer project’s
website ¥) shows the convoluted way policy logic must be specified in Polymer in
order to make policies safely composable. As this example illustrates, specifying
policies in Polymer requires care and expertise.

1.2 Contributions

We present PoliSeer, a GUI-based tool designed to make it simpler and more
convenient for non-experts to specify, visualize, modify, and enforce complex
policies. As far as we are aware, PoliSeer provides the first GUI for composing
arbitrary runtime security policies.

PoliSeer users import universally composable policies from a policy library,
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public class ConfirmAlIHTTP extends Policy {
private boolean userCancel = false, noAsk = false;
public Response query(Action a) {
aswitch(a) {
case (abs void NetworkOpen(String addr, int port)):
if (port===80 || port==443) {
if (noAsk) return new OK(this);
if (userCancel) return new ExceptionResponse(this);
return new InsertResponse(this,new Action(null,
“JOptionPane.showConfirmDialog(Component, Object,
String, int)”,
new Object[ ]{null, “Allow HTTP to " +addr+“?",
“Warning”,
new Integer(JOptionPane.YES_NO_OPTION)}));
}
¥
return new IrrelevantResponse(this);

public void accept(Response r) {
if (r.isExn()) userCancel = false;
if (r.isOK()) noAsk = false;
public void result(Response r, Object rslt) {
if (r.isIns() && ((Integer)rslt).intValue()==JOptionPane.NO_OPTION)
userCancel = true;
else if (r.islns() && ((Integer)rslt).intValue()==JOptionPane.YES_OPTION)
noAsk = true;
}
¥

Fig.1 Convoluted but composable Polymer policy requiring user confirmation before
making HTTP connections (taken from Ref. 4)).

compose them in meaningful ways by declaring arguments for all policy param-
eters, and generate code for the composed policy. We believe this process is
straightforward enough that system administrators and even advanced end users
can use PoliSeer to specify and enforce application-level policies; users simply cus-
tomize (i.e., specify arguments for) expert-authored policies. Hence, a primary
requirement for using PoliSeer is an ability to read and understand documenta-
tion for expert-authored policies.

Beyond specifying complex policies as compositions of simpler subpolicy mod-
ules, policy engineers can use PoliSeer to visualize complex policies holistically
(as shown in Fig. 7). Such high-level policy visualizations may improve the engi-
neers’ understanding of large and complex policies and help engineers locate and
isolate problematic policy modules.

Our implementation of PoliSeer uses Polymer as the underlying language of
universally composable policies; in other words, Polymer is the language in which
our PoliSeer implementation imports and exports policies. However, we have
partitioned the implementation into Polymer-specific and non-Polymer-specific
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modules to make PoliSeer readily portable to other policy-specification languages
with first-class and parameterized policies.

PoliSeer is a declarative, Turing-incomplete policy-specification tool, so it lacks
the expressiveness of imperative, Turing-complete policy-specification languages
like Polymer 2®, Naccio '), and PSLang !?). Instead, PoliSeer users must rely
on expert policy engineers to make useful universally composable policies avail-
able. This sort of tradeoff between expressiveness and usability is common with
security-management tools. We believe that PoliSeer strikes a good balance be-
tween expressiveness and usability because, like standard IDEs, engineers may
make use of PoliSeer’s convenience when it does not impede expressiveness, but
if greater expressiveness is required, PoliSeer users can always specify Polymer
policies on their own (or have experts create new policy libraries for them) and
then import those new policies directly into PoliSeer.

Because a non-expert is, by definition, unable to write complete policies in a
complex language like Polymer, PoliSeer is designed to avoid presenting users
with, and requiring knowledge of, language-specific details. Specifically, PoliSeer
caters to non-experts by sparing them from having to understand the complex
lexical, syntactic, and semantic rules of expressive policy-specification languages.

e Lexically, PoliSeer users do not need to understand the custom keywords of

specialized languages like Polymer; the only tokens PoliSeer users need to be
able to construct are for standard primitive values like integers and strings.

e Syntactically, PoliSeer users do not need to understand the grammatical

rules of programming languages. Every policy-specification language we are
aware of introduces specialized syntax for defining policies and the circum-
stances under which security-relevant actions should be allowed to execute.
In PoliSeer, users define policies simply by selecting policies from an exist-
ing library and supplying arguments for those policies, resulting in a tree
representation of policies. PoliSeer users may create, modify, and visualize
policies without understanding programming-language syntax by dragging
and dropping, selecting, and visually inspecting elements of these trees.

e Semantically, PoliSeer users do not need to understand programming-

language typing rules beyond the ability to construct standard primitive
values like integers and strings. Policy-specification languages typically intro-
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duce custom typing rules—for example, for typing policies, actions, results
of actions, and policy reactions to actions, as well as rules for managing
side-effects and/or rollbacks of imperative states. As described in Section 2,
PoliSeer does several things to spare users from having to understand these
frequently complex rules of semantics (e.g., PoliSeer automatically manages
policy-module systems and determines and checks policy-argument types).
PoliSeer abstracts the lexical, syntactic, and semantic details of policy-
specification languages into policy trees that can be created and manipulated
with much less expertise than policies in general-purpose programming languages.
The only requirements of PoliSeer users are that they can understand (1) basic
GUI operations (like dragging and dropping components and clicking on menu
items), (2) the semantics of library policies (e.g., a policy conjunction means
that both of the argument policies will be enforced simultaneously), (3) tree rep-
resentations of policies (i.e., that the children of a policy-tree node P represent
the arguments to P), and (4) how to specify standard primitive values (integers,
strings, etc). Note that users with any standard (GUI-based) operating systems
would have to understand all these things, and many more, to author policies
with existing tools.
Roadmap
We proceed as follows. Section 2 describes the design of the PoliSeer GUI;
Section 3 explains and evaluates our implementation of PoliSeer as a Java appli-
cation that inputs and outputs Polymer policies; Section 4 reports our experiences
implementing a case-study policy in PoliSeer; and Section 5 concludes.

2. The PoliSeer Interface

PoliSeer aims to provide a straightforward graphical interface for conveniently
and flexibly managing complex policies.
2.1 The Main Window
The main PoliSeer window consists of two panels, as shown in Fig. 2. The left
panel is the policy-selector panel; the right panel is the policy-tree panel.
e The policy-selector panel allows the user to navigate the machine’s file system
to find existing composable policies. Our implementation begins by popu-
lating the policy-selector panel with all subdirectories and .poly files (i.e.,
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Fig.2 Main PoliSeer window divided into policy-selector and policy-tree panels. The policy-
tree panel is displaying the default, empty policy.
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Polymer policy files) in the user’s home directory. The policy-selector panel
makes use of a standard interface for navigating the file system: clickable ar-
eas expand and contract subdirectories. When a user expands a subdirectory,
PoliSeer searches for, parses, and displays all policy files in the newly visible
directory. PoliSeer parses the policy files so that it can display the types of
parameters each policy expects (in its constructor) next to that policy’s name
in the policy-selector panel, as shown in Fig.2 (when multiple constructors
exist for the same policy, users select the desired constructor from a drop-
down list before inserting the policy into a policy tree). Because computer
users are accustomed to this sort of expand-and-contract navigation interface
(e.g., the Windows file explorer and many application programs employ the
same interface), navigating policy libraries is straightforward.

e The policy-tree panel contains a graphical representation of the policy cur-
rently being created, visualized, or modified. When PoliSeer begins exe-
cuting, it displays the empty policy as shown in Fig.2. The empty policy
consists of a single grayed-out node containing the text <Policy>, which
indicates that PoliSeer expects that node to be filled in with a policy. In
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| <Policy= | | <String= |

Fig.3 Policy-tree panel showing a root Audit policy parameterized by another Policy and a
String, though no children have yet been specified.

general, grayed-out nodes in a PoliSeer policy indicate incompletions in the
policy; the text in a grayed-out node indicates the type of data that must
be inserted into that node. In this way, PoliSeer communicates to the user
whether, and in what ways, policies are incomplete. For example, Fig. 3
shows a policy-tree panel for an incomplete, one-node Audit policy parame-
terized by another Policy and a String; the policy is incomplete until the
user specifies one Policy and one String argument for Audit.

The only windows incorporated into PoliSeer besides the split main window
are modal popup windows (for routine operations like selecting a location to load
a policy from or save a policy to) and a window for viewing policy source code
(described in Section 2.3).

2.2 Creating Policies

PoliSeer’s basic interface for creating policies is simple. Users may select a
policy in the policy-selector panel by left-clicking on the policy name. Having
clicked on a policy P in the policy-selector panel, the user may left-click on any
landing area L in the policy-tree panel to insert P into L. Valid landing areas
are grayed-out <Policy> nodes and branch-insertion points (BIPs) in the policy-
tree panel. PoliSeer automatically displays BIPs as small black squares in the
policy-tree panel on every branch into which a user could possibly insert a policy.

For example, Fig. 2 shows PoliSeer as it begins, with an empty policy-tree panel.
A user may add the Audit policy as the root of the policy tree by clicking on
the Audit policy in the policy-selector panel and then clicking on the grayed-out
Policy node in the policy-tree panel. The policy tree in Fig. 3 results from this
addition; Audit has been added as the root node of the policy, but two new
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Fig.4 Policy-tree panel as the user enters a String argument for the Audit policy.

grayed-out nodes have appeared because PoliSeer has parsed the Audit policy
and determined that it is parameterized by another Policy and a String. The
user may then insert a String as the right child of the Audit policy by clicking
on the grayed-out String node and entering the string in a pop-up window, as
shown in Fig.4. Users may enter other types of arguments to policies, such
as ints, floats, booleans, and chars, similarly to Strings, but PoliSeer will
first confirm that the user’s entry can be parsed as a value of the correct type.
Currently, PoliSeer can only import and manipulate policies with a primitive-
type String and Policy parameter, but all the policies provided in the standard
Polymer distribution® satisfy this constraint.

Continuing with this example, Fig. 5 shows a complete policy tree that results
from inserting a (childless) policy and a string into the grayed-out nodes of Fig. 3.
Two BIPs exist in Fig. 5 ; a user may insert a policy node into this policy above the
Audit root or above the DisSysCalls child of Audit. To insert a Conjunction
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‘ DisSysCalls| | =String="email.log"

Fig.5 Policy-tree panel showing an Audit policy with a subpolicy and string argument. This
complete policy disallows system calls (i.e., java.lang.Runtime.exec methods) at run-
time while logging all policy decisions to a file named email.log.

‘ Conjunction ‘ | =String="email.log"

|DisSysCalls‘ ‘ <Policy= ‘

Fig.6 The same policy-tree panel shown in Fig. 5, except that the user has now inserted a
Conjunction policy between the DisSysCalls and Audit policies.

policy between the Audit and DisSysCalls nodes, the user simply clicks on
the Conjunction policy in the policy-selector panel and then clicks on the BIP
between the Audit and DisSysCalls policies in Fig.5 ; the result is shown in
Fig. 6.

By building policy trees, PoliSeer users may specify complex policies. All the
superpolicies in policy trees can be thought of as metapolicies; superpolicies like
Conjunction specify how to combine any possible combination of constraints
imposed by subpolicies, even when those constraints conflict. For example, a
PoliSeer user may specify a policy as being the conjunction of two subpolicies
Py and P», where P, is defined to always respond to security-relevant actions in
the opposite way as P; (e.g., when P; OKs an action, P, halts the target, and
when P; does anything besides OK an action, P, OKs the action; this is the Not
superpolicy described in Section 4.1). Such a composition of conflicting policies
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Fig.7 Full tree for an example email policy (taken from Refs. 2), 3)).

is perfectly legal, and it is up to the semantics of the superpolicies to determine
what happens when policies specify conflicting constraints. In this case, the
Conjunction superpolicy obeys the strictest of its subpolicy constraints on each
security-relevant action, so the overall (Conjunction) policy will always obey
P;’s constraints as long as P; does not OK an action, but when P; OKs an
action, the overall Conjunction will have to obey P, and halt the application.
The ability to use metapolicies (i.e., superpolicies) to resolve conflicts between
composed subpolicies is one of the key benefits of universally composable policies
in systems like Polymer.

Having created a (complete or incomplete) PoliSeer policy, a user may save
it to a .psr file (which is simply a serialization of the policy tree) with the
File -> Save Tree menu option and may generate ready-to-enforce Polymer
code for the policy in a .poly file with the File -> Generate Policy Code
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option. Conversely, users may resume creating, visualizing, or modifying a saved
.psr policy with the File -> Load Tree option. When exporting an incomplete
PoliSeer policy to a .poly file, PoliSeer automatically parameterizes the exported
policy by all missing policy components (e.g., if the policy is missing one child of
a Conjunction superpolicy, then the exported policy’s constructor will accept a
Policy argument to fill in for that missing child).

2.3 Visualizing Policies

As Figs. 7, 8 and 9 demonstrate, PoliSeer’s policy-tree panel can provide a
useful high-level visualization of complex security policies as compositions of
simpler subpolicy modules. If PoliSeer’s visualization of a policy is too high level,
users can always choose the View -> Policy Source menu option to obtain
the source-code-level details of the most recently selected policy. Examining
a policy’s source-code documentation can be helpful for PoliSeer users when
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| DisSysCalls | | InterruptToCheckMem|
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Fig.8 The same policy tree shown in Fig. 7 but simplified by hiding non-policy nodes.

figuring out which arguments to specify for that policy. For example, a PoliSeer
user may see and be intrigued by the Audit policy, view the documentation in
the Audit source code, understand what the policy does and which arguments
it expects, include Audit in the policy tree, and supply appropriate child-node
arguments based on an understanding of Audit’s semantics.

As another aid for visualizing policy compositions, PoliSeer provides a tog-
gleable menu option View -> Show Non-Policy Nodes. This option removes
(or restores) non-policy nodes in the policy-tree panel. Removing non-policy
nodes from a policy tree may simplify the user’s view of a policy, as Figs. 7 and 8
demonstrate. Non-policy nodes often clutter a policy tree without providing
much insight into the policy’s organization. For example, non-policy nodes may
specify port-number, IP-address, or filename arguments to policies, which may
be irrelevant for understanding the overall policy structure.

2.4 Modifying Policies

Although we have found PoliSeer’s interface for creating and visualizing policies
convenient and straightforward, we have found policy-modification operations
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more nuanced and challenging to enable and implement.
PoliSeer users may modify policy trees in three ways:

(1) Users may swap two existing sibling nodes (and their subtrees) by drag-
ging and dropping one sibling node on another. Swapping subpolicies can
be useful when dealing with superpolicies that make semantic distinctions
between the order of their children (e.g., Polymer’s Dominates superpolicy
gives priority to its left child?»®). Nodes must have the same type to be
swapped (e.g., a String cannot be swapped with a Policy), and PoliSeer
currently does not support non-sibling node swapping due to policy-tree
circularities that arise when swapping a node with one of its ancestors.

(2) Users may replace a policy node P in the policy tree with a policy P’
selected from the policy-selector panel by left-clicking P’ in the policy-
selector panel and then left-clicking on P in the policy tree. PoliSeer only
allows P’ to replace P when the parameter types of P and P’ are well
aligned. Technically, this means that PoliSeer must be able to assign each
of P’s nonempty children to be children of P’ without introducing any type
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Fig.9 Warning displayed before deleting a node with multiple policy children. PoliSeer has highlighted the descendants that will

be discarded along with the node being deleted.

conflicts. If P and P’ are well aligned, PoliSeer performs the replacement
by making the P node be a P’ node and then traversing P’s children from
left to right and reassigning each nonempty child of P to the leftmost child
of P’ with the same type. In this way, PoliSeer attempts to allow policy
replacement in all cases in which it could possibly make sense.

Users may delete a policy-tree node by right-clicking on it. Before delet-
ing any nonempty policy-tree node, PoliSeer confirms the deletion with a
popup dialog box. When deleting a policy node N, the leftmost policy-
child of N takes the place of N in the policy tree, and PoliSeer discards
all other children of N. Because users may not expect this deletion seman-
tics, PoliSeer highlights all the about-to-be-discarded nodes and displays
a confirmation window before actually discarding the highlighted nodes.
Figure 9 illustrates this interface.
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When combined with the ability to insert policy nodes into any landing area in
a policy tree, these three operations provide users a complete palette of basic
policy-specification, -visualization, and -modification tools.

3. Implementation

We have implemented PoliSeer as an open-source Java application, available
online at http://www.cse.usf.edu/ ligatti/projects/poliseer/. The implementa-
tion is 3351 lines of code in 12 source-code files.

3.1 Architectural Overview

Our PoliSeer implementation consists of three high-level modules:

(1) The front end (1828 lines of code). This module reads and parses Poly-
mer files for input into PoliSeer. When a user opens a directory in the

policy-selector panel, PoliSeer parses the Polymer files in that directory to
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Fig.10 Architectural overview of PoliSeer.

determine how they are parameterized, that is, which types of arguments
the policies’ constructors expect to receive. PoliSeer uses this type informa-
tion to ensure that all policies receive arguments of the proper types and to
prepare grayed-out children in the policy tree, as discussed in Section 2.2.
Our front end parses Polymer files with a parser generated by JavaCC, a
top-down parser generator .
(2) The PoliSeer GUI (1451 lines of code). This module contains all the code
to implement PoliSeer’s graphical user interface, as described in Section 2.
(3) The back end (72 lines of code). This module generates Polymer code for
the policy tree being visualized. Users can input the code that this module
generates directly into the Polymer system, which will then enforce the
specified policy on untrusted Java-bytecode applications.
Figure 10 summarizes PoliSeer’s implementation architecture. The Polymer-
dependent front and back ends are distinctly separated from the Polymer-
independent GUI, so developers can change PoliSeer’s underlying policy-
specification language from Polymer to a language L by writing and plugging
in new front and back ends for L.
3.2 Performance
We have tested our implementation’s performance during basic operations such
as parsing Polymer files and inserting nodes into policy trees. The tests were
performed on a Sony Vaio laptop with Intel Core2 Duo 1.73 GHz CPUs and
1GB of RAM, running Kubuntu 8.10. For all tests, we report running times
obtained by averaging real execution times over ten executions.
Our first test measured the time taken for PoliSeer to start up, build the GUI,
and exit at the end of PoliSeer’s main method. This time included the virtual-
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Fig.11 PoliSeer performance rendering policy trees during node insertion.

machine start-up time and was just 830 ms on average.

Next, we measured the time taken for PoliSeer to parse the Polymer files in the
policy library to determine the types of parameters in the policies’ constructors.
With an average Polymer-policy-file size of 84.5 lines of code, PoliSeer parsed the
Polymer files in only 3.1 ms on average.

Our third test measured the amount of time PoliSeer took to render a policy
tree during insertion of nodes into the tree. This rendering time dominates the
amount of time it takes for PoliSeer to insert new nodes into policy trees; node-
insertion time is O(lgn) for finding where to modify the tree data structure, O(1)
for modifying the tree at that point, and O(n) for rendering the new tree with
the inserted node (where n is the number of nodes in the policy tree). Figure 11
confirms the linear growth of policy-tree rendering. All tree-rendering-intensive
operations in PoliSeer (i.e., node insertion, swapping, replacement, and deletion)
exhibit a performance similar to that shown in Fig.11. Although tree-rendering
times never exceeded one second, even for trees with hundreds of nodes, a good
optimization to consider in the future would be to only re-render the modified
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Fig.12 PoliSeer performance generating Polymer code.

portions of trees during policy-tree manipulations.

Finally, we measured the time taken for PoliSeer to generate Polymer code
files from policy trees. We implement code generation by (recursively) preorder-
traversing the policy tree, while concatenating strings to construct every policy-
tree node. As Fig. 12 illustrates, PoliSeer’s code-generation time remains low
(less than a second) even for policies with many hundred nodes.

In summary, all the basic PoliSeer operations have tolerable performance, and
performance delays do not even become noticeable until the user manipulates
policy trees containing several hundred nodes.

4. Case Study

We have designed a complex case-study PoliSeer policy that restricts the run-
time behavior of PoliSeer itself; that is, we have created a PoliSeer-controlling
policy in PoliSeer. Moreover, we have successfully executed PoliSeer in the Poly-
mer system while enforcing this PoliSeer-created policy.
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4.1 Policy Overview

Figure 13 displays the policy tree for our case-study policy. This policy has
a Conjunction as its root, so it constrains the untrusted application (PoliSeer
in this case) by always responding to a security-relevant action with the most
restrictive of its subpolicies’ responses to the same action. In other words, the
case-study policy always attempts to respect the restrictions of two high-level
subpolicies.

We based the first of these two high-level subpolicies on policies described in
earlier work 2. This branch of the case-study policy enforces constraints that
should be included in all Polymer policies to prevent the untrusted application
program from using reflection, constructing class loaders, writing .class files, or
invoking system-level functions (with java.lang.Runtime.exec methods). This
branch also includes the InterruptToCheckMem policy, which notifies the user if
the virtual machine’s memory consumption exceeds a specified threshold. All of
these subpolicies are conjoined by Dominates superpolicies, which act as short-
circuit Conjunction policies in our case study (though their precise semantics is
more subtle?%).

The second of the two high-level subpolicies in our case-study policy speci-
fies constraints that we particularly wanted to enforce on PoliSeer; something
would be wrong if PoliSeer violated any of these constraints. We call this branch
of policies the PoliSeer-specific policy. Like the entire case-study policy, the
PoliSeer-specific policy decomposes into two branches, joined with a Dominates
superpolicy (which again acts as a short-circuit Conjunction here).

The first branch of the PoliSeer-specific policy is the NoNetworkOpens policy,
which disallows the untrusted application from opening any network sockets.

The second branch of the PoliSeer-specific policy restricts the PoliSeer applica-
tion (i.e., code in the poliseer package)—but not the case-study policy we are
enforcing on PoliSeer (i.e., code in the poliseer.policy package)—{rom opening
files with extensions other than .psr, .poly, or .class. Intuitively, although the
case-study policy may open other types of files (perhaps because, e.g., we later
extend the policy with auditing capabilities that necessitate opening log files),
the PoliSeer application itself should have no effect on the file system except
for reading and writing PoliSeer (.psr), Polymer (.poly), and Java-bytecode
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Fig. 13 Case-study policy, specified in PoliSeer, that constrains the PoliSeer application itself.

(.class) files. The application will actually not be able to write .class files

(because the NoWriteWithExt policy already disallows it), but the case-study

policy does allow the application to read .class files (because Java compilers

often optimize benign operations like initializing nested classes by having the
outer class’s initializer read the bytecode of the inner class).
This second branch of the PoliSeer-specific policy contains four subpolicies:

(1) TryWith combines two subpolicies by first obtaining its left child’s response
to the security-relevant action A that the untrusted application is attempt-
ing to execute. If the left child allows A to execute unconditionally then
so does the TryWith superpolicy; otherwise, TryWith responds to A with
whatever response its right child returns for A.

(2) InspectStackFor takes a String argument S and inspects the runtime
call stack for a method called from package S. More specifically, the policy
traverses the call stack from the most recent to the oldest method invocation
and disallows the security-relevant action the untrusted application is about
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to execute if and only if the traversal reaches a call from S before reaching
a doPrivileged call.

(3) Not inverts the response of its subpolicy. For example, if the subpolicy
responds to a security-relevant action by halting, the Not superpolicy will
respond by allowing the action.

(4) OpenWithExt takes a String argument S and allows file-open actions to ex-
ecute if and only if they access files with names that end with file-extension
S.

The case-study policy enforces the desired file-open subpolicy by chaining to-
gether TryWith combinators. Every child of the TryWith policies allows one type
of file-open action to execute; a file open is only disallowed when none of those
children allow it. In turn, the TryWith children allow actions from outside the
poliseer package, actions from within the poliseer.policy package (techni-
cally, from Not outside the poliseer.policy package), actions that open .class
files, actions that open .poly files, and actions that open .psr files.
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4.2 PoliSeer Performance in Polymer

We measured the performance of PoliSeer executing in the Polymer system
while enforcing the case-study policy. The measurements provide some insight
into the runtime overhead induced by enforcing Polymer policies.

In general, runtime-policy-enforcement overheads depend on the complexity of
the policy being enforced and the number of times that policy must respond
to security-relevant actions. One important consideration in this regard is that
our case-study policy only reasons about (i.e., considers security relevant) appli-
cation methods that open files, open network sockets, make system-level calls,
implement reflection, or construct class loaders. Enforcing the case-study policy
induces runtime overhead only when the untrusted application (PoliSeer) invokes
one of these security-relevant methods. Therefore, operations like inserting nodes
into policy trees, which do not execute security-relevant methods, run equally
quickly regardless of whether the case-study policy is being enforced. On the
other hand, application-level operations that do execute security-relevant meth-
ods experience overhead when the case-study policy is being enforced, and that
overhead is proportional to the number of security-relevant methods executed.

The average time for PoliSeer to start up in the Polymer system was 3.7's, much
higher than the 0.83 s start-up time we measured when the case-study policy was
not being enforced. This significant start-up overhead is common in Polymer due
to the large number of files that get opened as the virtual machine loads classes
during application startup (recall that our policy considers file openings security
relevant).

Besides the start-up overhead, none of the overheads induced by enforcing the
case-study policy on PoliSeer were noticeable. The average time to parse Polymer
files increased by 0.8 ms, and the average time to generate Polymer code increased
by 1.3ms (regardless of the policy size), when enforcing the case-study policy.
The case-study policy has to respond once to each Polymer-file parsing and code-
generation operation because these operations each entail one security-relevant
file-open action. Hence, we can infer that enforcing the case-study policy added
approximately 1ms to the execution time of every security-relevant action.

4.3 Experiential Observations

Designing, specifying, and enforcing the case-study policy was a valuable ex-
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perience for us. We found that PoliSeer made it convenient—but not a foolproof
process—to specify and generate Polymer code for the case-study policy.

Summary of Experiences Designing Policies

Policy modularization was immensely helpful for designing the case-study pol-
icy because it enabled us to decompose high-level policy goals into simpler sub-
goals. For instance, we wished to enforce that PoliSeer code, except for code in
the poliseer.policy package, could only open .psr, .poly, and .class files.
It was natural for us to decompose this high-level goal into several subgoals, each
testing for one of the conditions in which a file-open action would be allowed
to execute; the overall policy only rejects actions that fail all the tests. The
tests check, in turn: whether a non-PoliSeer method invoked the file-open action,
whether a poliseer.policy method invoked the file-open action, whether the
action is opening a .class file, whether the action is opening a .poly file, or
whether the action is opening a . psr file. Composing all of these subpolicies with
a (reusable) TryWith superpolicy yielded the desired high-level policy. This was
a convenient (and actually enjoyable) way to specify a complex policy.

We also found it important when designing policies in PoliSeer to have a robust
policy library available, as PoliSeer users who are unfamiliar with the underlying
policy language (Polymer) will have difficulty constructing and importing their
own Polymer policies. Fortunately, many existing policies comprise the majority
of the policies we have constructed. For example, the Conjunction, Dominates,
TryWith, and Not superpolicies enable subpolicies to be composed in a rich vari-
ety of ways. Other common policies perform auditing or enforce access controls
on network sockets, files, and other objects. We implemented the entire case
study with only a standard library of Polymer policies, though we did have to
increase the library with four policies (Not, InspectStackFor, NoNetworkOpens,
and OpenWithExt) before specifying the case-study policy in PoliSeer because
Polymer’s policy library is nascent. We believe each of the policies we added
to the standard library are generic and will be useful to incorporate into a wide
array of PoliSeer policies.

Similarly, it was important for the Polymer policies we chose to include in
our case study to be well documented, so we could understand their semantics
during composition (by viewing the policy source, as described in Section 2.3).
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We often found ourselves examining the policy documentation because a policy’s
name alone did not provide enough information to understand which arguments
the policy expected. In all cases, though, we obtained a sufficient explanation of
a policy’s semantics from a quick examination of its source-code documentation.

Summary of Experiences Using the PoliSeer GUI

Overall we found the PoliSeer GUI a great aid for policy specification and
visualization. Nonetheless, a couple GUI limitations become apparent during
the case study. First, PoliSeer lacks a way for users to select an entire subtree
of nodes. Subtree selection would be useful for conveniently moving, replacing,
or deleting entire subtrees. Subtree selection could also make it convenient to
generate policy code for just one subtree within the overall policy-tree panel; for
example, a user could modularize and simplify one part of a complex policy by
selecting a subtree of the complex policy, naming that subtree P, generating code
for P, and then replacing the selected subtree with P.

Another difficulty related to scaling and whitespace in the policy-tree panel.
We found that the default policy-tree scaling made the organization of small-
and medium-sized policies clear, but it became more difficult to get a good high-
level visualization of policies as they grew larger. A potential improvement to the
PoliSeer GUI would be a mechanism for scaling policy trees and/or the whitespace
between nodes in policy trees. Such scaling would enable users to visualize more
policy-tree information on one screen without scrolling; this idea is similar to
PoliSeer’s existing ability to toggle between showing and hiding non-policy nodes
(as described in Section 2.3).

5. Conclusions and Future Work

We have presented PoliSeer, a tool for managing complex security policies.
PoliSeer users rely on policy-composition experts to distribute libraries of uni-
versally composable policies (written in a language like Polymer). PoliSeer users
build complex policies by composing those expert-written policies in meaningful
ways. For example, we have constructed complex email-client and PoliSeer poli-
cies (Figs. 7 and 13). In our experience, PoliSeer has been a great aid for quickly
specifying and generating code to enforce complex policies built as compositions
of simpler subpolicies. We believe PoliSeer is useful, even for expert policy en-
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gineers, for clearly and conveniently visualizing complex policy trees. Moreover,
PoliSeer’s interface contains several considerations for conveniently modifying
policies, such as policy replacement, branch-insertion points (BIPs), and branch
deletions (cf., Fig. 9). Thus, we view PoliSeer as an integrated development envi-
ronment (IDE) for security policies, providing policy engineers the same sorts of
benefits that traditional IDEs provide software engineers (convenience of creating
high-level specifications and visualizations to minimize errors in, or totally avoid,
low-level programming tasks).

There are many opportunities for future extensions to the PoliSeer project.
One branch of work would involve conducting experiments and surveys to de-
termine how usable PoliSeer’s target users (system administrators and advanced
end users) find the tool. Another branch of possible future work would involve
improving the PoliSeer application to address some limitations that arose during
the case study, which Section 4.3 introduced. In particular, we would like to
consider additions to PoliSeer’s interface for:

e Selecting groups of nodes to enable moving, saving, replacing, and deleting

entire subtrees of policies

e Scaling the whitespace between nodes in a policy tree, or even scaling the

size of the entire policy tree

e Commenting on parts of policy trees, for example, to allow the user to draw a

border around a group of nodes, possibly shade the space within that border,
and add textual comments to document the purpose and behavior of nodes
within that border
We hope that with continued research and development, policy-engineering tools
will be as helpful and usable as standard software-engineering tools.
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